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Introduction 

This manual explains how to install and configure the Thermo Scientific 
iTEVA Security software. 

The iTEVA Security software can be thought of as a client-server 
application which consists of three separately installable components. 
These components are: 

1. The Thermo Security Server and Security Administration 
Software 

The Thermo Security Server software provides security information to 
client applications, such as iTEVA. It runs in the background as a 
Windows® service. 

The Thermo Security Administration Software allows an administrator to 
define and manage the security policies for Thermo client applications.  

Together, these two components provide the ‘server’ side of the client-
server relationship with the iTEVA Security client software providing the 
client side. 

 

2. The iTEVA Security Client Software 

The iTEVA Security client software provides the functionality to control 
an iCAP 6000 series spectrometer and to collect and process its data. By 
communicating with the Thermo Security Server, it enforces the access 
control, system policy and electronic signature behaviour as defined by an 
administrator. 

 

3. SQL Server Express 

SQL Server Express is a database server that provides secure storage for 
the electronic records produced by the iTEVA client software.   

Together, these components integrate with the security and auditing 
features of the Windows operating system to provide: 

 Traceability of user operations through audit trails and event logs 
 Access control via a secure user authentication process  
 Prevention and detection of uncontrolled changes to electronic 

records 
 Electronic signatures based on the user’s  Windows log-on credentials  

When correctly installed and configured, these features help your 
laboratory meet regulatory requirements, such as FDA 21 CFR Part 11. 
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Installation of the iTEVA Security software consists of the following 
steps: 

 

1. Configure Windows Administration 

The iTEVA Security software integrates with various security and 
auditing features provided by the Windows operating system, therefore it 
is essential that before installation begins, these features be reviewed and 
configured appropriately.  

 

2. Install the Thermo Security Server and Administration Software 

An administrator must install the Security Server and Administration 
software onto a designated server computer. Once installed the 
administrator can transfer the ability to run the administration software 
to any users or user groups as required. 

 

3. Configure the Security settings for the iTEVA Security Client 
application 

Once the Thermo Security Server and Administration Software has been 
installed, the client application’s security settings must be configured to 
provide the access control, system policy and electronic signature 
behaviour required by your laboratory or regulatory body. 

 

4. Install and configure SQL Server Express  

SQL Server Express must be installed and configured appropriately in 
order to protect the integrity of your analytical data by preventing it from 
being modified by unauthorised individuals or in an uncontrolled 
manner. 

 

If required, iTEVA Security can connect to an existing instance of SQL 
Server, in which case installation of SQL Server Express is not required. 
Any existing instance of SQL Server must however be configured as 
described in this manual. 

 

5. Install and configure the iTEVA Security Client application 

Instances of the iTEVA Security Client software are installed and 
configured to communicate with the Security Server and to access secure 
analytical databases hosted by SQL Server Express. Analysts may then use 
the software to collect, process store and review analytical data. 

 

Installation 
Steps 

Note 
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Failure to perform all of these steps correctly may compromise the 
security of the installation and the integrity of your analytical data, and 
may result in an inability to comply with regulatory requirements, such as 
FDA 21 CFR Part 11.0 

 

Note 
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The Installation Process 

iTEVA Security can be installed to operate in a number of different 
networked or stand-alone configurations. 

The steps required to make Windows ready for installation of iTEVA 
Security should have already been taken as part of the customer pre-
installation process. If for any reason they have not, then these are 
outlined below. 

 

The configurations and the process of setting up Windows for each 
configuration are described in the following document which is supplied 
on the iTEVA Security installation CD:   

Program Files>ThermoAdmin>SecAdminUserGuide.pdf 

If you are unfamiliar with the concepts of Windows administration, 
please read the chapter Overview of Windows Administration first. This 
will explain the concepts behind the processes described later. 

 

Follow the detailed instructions in the chapter Setting up Windows 
Administration for the configuration that matches your own 
environment. 

 

Be sure to follow the relevant instructions depending on whether your 
system is Windows XP or Windows Vista/Windows 7, networked, or 
stand-alone. 

Disregard the chapter ‘Setting Service Accounts’ as this describes features 
of the Thermo Security and Administration software that are not used by 
iTEVA Security. 

 

iTEVA users must have membership of the ‘Power Users’ group. This is 
because Windows will only allow ‘users’ to run ‘certificated’ applications 
and iTEVA is not a ‘certificated’ application. 

 

To grant iTEVA users membership of the Power Users group, through 
the control panel select Administrative Tools 

Select Computer Management then Local Users and Groups. 

In the list of Groups double-click on Power Users to open the Power 
Users Properties Window. 

Add all the required users. 

Configuring 
Windows 

Administration 

Note 

Power Users 

1 

2 

3 



Thermo Fisher Scientific                                             Page 7 of 49                                 iTEVA Security Installation Manual v5.8 

 

By default, ‘Power Users’ are able to change the system time and date 
settings. It is crucial for the integrity of iTEVA Security that only 
‘administrators’ can do this. 

 

In networked environments this functionality will be administered by the 
network administrators, and the following steps should only be necessary 
for stand-alone configurations. 

 

To restrict this control to ‘administrators’ only, through the control 
panel select Administrative Tools 

 

Select Local Security Policy  > Local Policies > User Rights 
Assignment 

 

Double-click on the policy, Change the system time 

 

 

 

 

 

 

 

 

 

 

 

 

If the group ‘Power Users’ is there remove it from the list so that only 
‘Administrators’ have permission to change the system time. 

 

1 of 9 Complete 

Disable Time and 
Date Changes 

Note 

1 

2 

3 

4 
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The Thermo Security Server and Administration software is installed 
from the iTEVA Security installation CD. It must be installed by 
someone who is a member of the Administrators group on the computer 
that it is being installed to and it must be installed on a disk or partition 
that is formatted with the NTFS file system as only this file system is 
capable of using security attributes on files, an essential capability for 
protecting the security administration database from unauthorised access. 

 

Insert the installation CD into the CD drive of the computer that will be 
used as the server. The installation program should start running 
automatically. If it does not, using windows explorer, navigate to the 
contents of the CD drive and double-click on the file: setup.exe. 

 

 

 

 

 

 

 

 

 

 

 

 

Click Security Server. 

 

 

 

 

 

 

 

 

 

 

 

Installing the
iTEVA Security

Server and
Administration

Software

1 

2 
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Click Install Security Administration. The installation wizard should 
start. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Click Next and accept the license Agreement.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Click Next. On the customer information page, enter your username and 
organisation name.  

3 

4 

5 
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If the administration software is only ever to be accessible by the user 
performing the installation, select the Only for me button. If, on the 
other hand you envisage that other users will be performing 
administrative tasks, select Anyone who uses this computer.  

This only controls whether or not a shortcut to the Administration 
software appears on the desktop and on the Windows start menu for the 
selected user(s). You will later be able to define exactly who can and 
cannot perform administrative tasks. 

 

 

 

 

 

 

 

 

 

 

 

Click Next. The custom setup dialogue allows you to change the location 
where files are installed. If you do this, always use the same location each 
time you install the software so that files are upgraded correctly when 
subsequent versions are installed. Typically, default locations are used for 
installation. 

 

 

 

 

 

 

 

 

 

 

 

Note 

6 
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Click Next and then on the final install dialogue, click Install. The 
installation will now proceed. Click Finish to end the installation wizard 
when installation has run to completion. 

 

From the installation window for the Security Server, click on Locate or 
Change Server, as in the screen shot below. 

 

 

 

 

 

 

 

 

 

 

 

 

The Locate Security Server dialogue is displayed. Click search to find the 
local PC. 

 

 

 

 

 

 

 

 

 

 

In a networked configuration the Domain field will automatically default 
to the name of the domain that the computer belongs to. Accept the 
default and enter a dot ‘.’ in the Server Name field and click OK.  

In a stand-alone configuration both the Domain field and the Server 
Name field will default to the name of the stand alone computer. Accept 

7 

8 

9 
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the defaults and click OK. It may be necessary to click Search to fill the 
fields. 

 

Click Back on the iTEVA Security installer. 

 

 

 

 

 

 

 

 

 

 

 

Click Close on the iTEVA Security installer. 

 

There should now be a shortcut on your desktop for the Thermo Security 
administration application. Double click this icon to start the application. 

 

 

A Logon Authentication dialogue will be displayed. 

 

 

 

 

 

Note: if the password has been created as blank, then this logon may fail. 

 

 

Enter your Windows user name and password and click OK. The 
Security Administration software will now start. 

 

 

10 

11 

12 
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Select Add Application from the file menu and in the browser dialogue 
that is displayed, navigate to the CD drive containing the installation 
CD. Select the file iTEVA.xml and click Open. 

 

The Navigation pane of the Security Administration software should now 

display an icon representing the iTEVA client application, in addition to 
the existing icon representing the Security Administration application 
itself: 

 

  

 

 

13 
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Click on the plus sign ‘+’ next to the Admin icon. The access Control 
Folder appears: 

 

 

 

Click on the plus sign ‘+’ next to the Access Control folder. The 
Administer Security Database icon appears: 

 

 

 

Click on the Administer Security Database icon. A list of access rights 
appears in the right hand pane. The built-in Windows group 
‘Administrators’ should already be granted the right to administer the 
security database. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

You may now specify the users and/or groups of users who will have the 
right to run the Security Administration software. To add a user or 
group, select the name of the user or group from the Names list and click 
the Add button. The check mark next to the name indicates that the user 
or group has been granted the right to run the Security Administration 
software. 

To remove a user or group from the list, select the user or group from the 
Access Rights list and click the Remove button. 

 

14 

15 

16 

17 
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Select ‘Save Settings’ from the File menu. This will write the changes you 
have made into the security database. The Security Administration 
software can now be shut down by selecting ‘Exit’ from the file menu. 

 

 

2 of 9 Complete 

 

18 
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This process consists of: 

 Granting the desired access rights to users or groups of users  

 Setting the required system policies  

 Configuring the use of electronic signatures  

 

This process must be performed by someone who has been granted the 
right to run the Security Administration software.  

 

Listed below is a description of the security settings that are specific to the 
iTEVA client application. For a general description of how to use the 
Security administration software, please refer to the chapter Using 
Security Administration in the document SecAdminUserGuide.pdf. 

 

 

The following access control settings are available for the iTEVA client 
software. 

 

 Run iTEVA Security 

Users with this right are able to log in to the iTEVA client software. 

 

 Edit System Settings 

Users with this right are able to make changes to any of the parameters 
that appear on the options and instrument options pages in the iTEVA 
client software, including the right to run the Database Wizard. In a 
stand-alone configuration (client and server installed on the same 
computer), this allows the user to create analytical databases and to attach 
and detach them on SQL Server Express.  

 

It is strongly recommended, that in a regulated environment, for example 
where compliance with 21 CFR Part 11 is required, this access right is 
only granted to those users who also have the right to administer security 
settings i.e. users who can run the Security administration software. This 
is because a user who creates an analytical database is, by default, the 
‘owner’ of that database, and this confers certain privileges such as the 
ability to make uncontrolled edits to the contents of the database, from 
outside the controlled environment of the iTEVA Security software.  

 

Users must have this right to be able to perform a firmware upgrade to 
the iCAP instrument. 

Configuring 
Security settings 

for the iTEVA 
Security client 

application 

Configuring 
Access Control 

Settings 

Note 
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Users with this right are able to change the default plasma conditions that 
are set following plasma ignition (post ignition conditions). 

Users with this right are able to archive Full Frame sample data to a file 
that is separate from the analytical database, thereby removing it from the 
analytical database. 

Users with this right are able to copy analytical methods and results 
between databases and to delete methods and samples from analytical 
databases. The ability to copy and delete samples, also requires the ‘Edit 
Samples’ access right to be granted. 

 

 Edit Map Database 

Users with this right are able to make changes to the Map Database. 
This allows a user to mark which emission lines are available for analysis, 
which lines are selected by default when the element is added to a method 
and to define the default width and height of the examination region for 
each emission line. 

 

 Edit Methods 

Users with this right are able to create and edit analytical methods. 

 

 Edit Samples 

Users with this right are able to make changes to sample data after the 
sample has been collected, such as deleting repeats, changing the regions 
of interest (central and background points), recalculating the sample with 
a different concentration factor or changing the sample identification. 

 

 Edit Sequences 

Users with this right are able to create and edit sequence automation 
sessions (auto-sessions). This includes the ability to add or delete samples 
from the auto-session. 

 

 

 Create Reports 

Users with this right are able to create analytical reports using the 
Publisher application. 
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 Override method parameters on ‘run sample’ dialogues 

Users with this right are able to override some of the method parameters, 
such as the number of repeats and sample flush time when running 
samples. In a regulated environment, routine users would not ordinarily 
have this right granted as it allows samples to be collected under 
conditions that are not reflected in the method, thus removing 
traceability between the sample and the method. However, for those users 
involved in method development, it is often useful to be able to quickly 
override these parameters between samples at run time, without having to 
perform the normal method edit/save process. 

 

The following system policies are available for the iTEVA client software. 

 

 Audit Information Events 

By default, the iTEVA client application logs all significant system events 
in the Windows event log of the server computer (the one running the 
Thermo Security Server service.) Such events include all instrument errors 
(e.g. plasma went out during analysis, failed to connect to an analytical 
database etc.) and all successful and failed user authentications (i.e. entry 
of username and password for a given user account). By opting to audit 
information events, this information is supplemented by more detailed 
information about less critical events. This includes events such as plasma 
ignition, auto-sampler run started/completed, running sample x etc. 
Whilst this provides a more detailed account of all the activity associated 
with each instrument, it can result in very large amounts of data being 
stored in the event log. 

As this information is already stored locally in the iTEVA journal on each 
client computer, it is recommended that most labs do not routinely audit 
information events. 

 

 Database Application Role Password 

When iTEVA writes data (methods, samples etc.) to an analytical 
database it provides a special password to the SQL Server that identifies 
the application as being the iTEVA application. SQL Server compares 
this password with one stored in the database and only grants access to 
write to the database if they match. If any other application attempts to 
write to the database, it will fail to do so as it cannot provide the correct 
password. This prevents analytical data from being modified in an 
uncontrolled manner, even by users who have been granted the right to 
access the database using the iTEVA application. 

 

Configuring 
System Policies 
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The default password, known as an application role password is complex, 
consisting of a random string of characters and. Under normal 
circumstances this password need never be changed. 

However, if your regulated environment requires that all passwords 
related to data security be changed on a frequent basis, this can be 
achieved via this system policy. 

  

If you specify a database application role password in the Security 
Administration software, the iTEVA client application will use this 
password instead of the original one. Any password you specify must 
adhere to certain rules regarding complexity. 

 The password must be at least six characters long.  

 The passwords must contain elements from three of the four 
following types of characters. 

 

 Character types Examples

 English uppercase letters A, B, C, ... Z

 English lowercase letters a, b, c, ... z

 Westernized Arabic numerals 0, 1, 2, ... 9

 Non-alphanumeric characters (special 
characters) 

$, ! , % ,^

 

 

After setting a new application role password, the iTEVA client 
application will automatically store this password in any new database 
that is created and attached to SQL Server using the database wizard. To 
change the password that is stored in existing analytical databases, you 
must use the database wizard to first detach, then re-attach the database. 

 

Four example signature meanings are provided by default. If you wish to 
use electronic signatures, these should be reviewed and edited to suit the 
roles and responsibilities within you organisation. Signature meanings 
behave like access rights in that each signature meaning can be used only 
by those individuals who have been granted the right to do so. 

Configuring 
Signature 
Meanings 
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SQL Server Express is installed from the iTEVA Security installation CD. 
It must be installed by someone who is a member of the Administrators 
group on the computer that it is being installed to. 

In a networked environment it is commonly installed on the same 
computer as the Thermo Security Server and Administration software as 
it is commonly administered by the same person(s). 

In a stand-alone environment it is installed on the single computer that is 
acting as both client and server.  

 

 

Insert the installation CD into the CD drive of the computer that will be 
used as the server. The installation program should start running 
automatically. If it does not, using windows explorer, navigate to the 
contents of the CD drive and double-click on the file: setup.exe. 

 

 

 

 

 

 

 

 

 

 

 

Click SQL Express. 

 

 

 

 

 

 

 

 

 

 

Installing and 
configuring SQL 
Server Express 

1 

2 
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Install Pre-Requisite Components.  

SQL Server express requires the following components to be installed. If 
you are unsure whether these components have already been installed on 
your system run the installation process for each anyway and they will be 
installed if necessary. 

 

.NET V2 – if this is not installed then an error message will tell you 
when you try to run SQL Express Setup. In this case  run the .NET 
update ( Click .NET V2  ). 

 

Microsoft Installer V3.1– if this is not installed then an error message 
will tell you when you try to run SQL Express Setup. In this case run the 
MSI update ( Click Microsoft Installer V3.1). 

   

MDAC Update – if this is not up-to-date then the installation program 
will signal that in the System Configuration Check stage (See below). In 
this case, click MDAC Update. 
 

 

Open the instructions for installing SQL Server by clicking on the link 
Setup SQL Express With iTEVA. 

 

Click Install SQL Express to start the installation program. 

Follow the instructions in the opened document. 

 

At this point if a required component is not installed the installer will 
indicate to you with an error message - refer to step 3 above and install 
the required update package by clicking on the respective links and 
following the installation instructions. 

  

 

 

 

 

 

 

 

 

3 
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Click Back on the iTEVA Security installer. 

 

 

 

 

 

 

 

 

 

 

 

 

Click Close on the iTEVA Security installer. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

3 of 9 Complete 
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If you have installed SQL Server express for use in a networked 
environment, it must be configured to communicate over your network. 

 

These steps are NOT required if SQL Server Express has been 
installed to operate in a stand-alone environment. If this is the case, 
skip steps 1-10 below and go to the section Creating User Logins for 
SQL Server Express. 

 

 

On the computer on which SQL Server Express is installed, run SQL 
Server configuration manager:  

 

Start>Programs>Microsoft SQL Server 2005>Configuration Tools>SQL 
Server Configuration Manager 
 
 

 

 

 

 

 

  

 

 

Click SQL Server 2005 Network Configuration, and then double-click 
on Protocols for iTEVASECURITY. 

 

 

 

 

 

 

 

 

  

 

Configuring SQL Server 
Express for use with 

remote clients 

1 

2 
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Double click on TCP/IP to display the TCP/IP properties page: 

 

 

 

 

 

 

 

 

 

 

 

 

  

 

 

Click to set the Enabled field to Yes. Then click OK and OK again to 
acknowledge the warning prompt. 

 

Close SQL Server Configuration Manager. 

  

The changes you have made will not become effective until you have 
stopped and re-started the SQL Server Service. To do this, open the 
Services applet in Windows control panel: 

Start>Settings>Control Panel>Administrative tools>Services 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

3 

4 

5 
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Scroll down to the service named SQL Server (ITEVASECURITY) and 
double-click on the Service name. The service properties dialogue is 
displayed. 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

 

Click Stop. Windows will now attempt to stop the service, which should 
succeed. The Stop button will now be disabled and the Start button will 
become enabled. 

 

Click Start. Windows will now attempt to start the service, which should 
succeed, resulting in the changes taking effect. 

 

Click OK to close the Service Properties dialogue, and then close the 
Windows Services applet. 

 

 

Complete (Networked installations only) 
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All users of the iTEVA client software, who need to be able to access data 
stored in an analytical database, will need to have a log-in created for 
them in SQL Server Express. Log-ins can either be created individually 
for each user, or can be created for Windows user groups, thereby 
simplifying the administration process. 

 

These steps must be performed by someone who is a member of the 
‘Administrators’ group on the computer onto which SQL Server Express 
has been installed. 

 

Start SQL Server Management Studio Express: 

 

Note for Windows 7: You may need to run SQL Server Management 
Studio Express as an administrator. Use the Start menu as below, but 
instead of just running the Management Studio Express, Right Click on 
it and select Run as administrator. 

 

Start>Programs>Microsoft SQL Server 2005>SQL Server Management 
Studio Express 

 

The ‘Connect to Server’ dialogue will be displayed. 

 

 

 

 

 

 

 

 

 

 

 

  

 

 

 

 

Creating User 
Logins for SQL 
Server Express 

1 
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Select the server name that you wish to connect to, which will be in the 
form : <computername>ITEVASECURITY>. Select Windows 
Authentication as the authentication mode and click Connect. The 
Object Explorer window should then be displayed for the 
ITEVASECURITY instance of SQL Server. 

 

 

 

 

 

 

 

  

 

 

Click on the + next to Security to expand the Security branch of the 
object explorer tree. 

 

 

 

 

 

 

 

 

  

 

 

 

 

 

 

 

 

 

2 
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Right-click on the Logins branch of the tree to display the logins popup 
menu. 

 

 

 

 

 

 

 

 

 

 

 

 

  

Click on New Login… to display the Login – New dialogue. 
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Click on Search… to search for a user or group for which you wish to 
create a SQL Server log-in. 

The “Select User or Group” below will be shown. 

 

 

 

 

 

 

 

 

Type names into the ‘object name’ field and click Check Names to 
confirm name. Alternatively, click Advanced… and the Find Now for a 
list of available names. Choose a name and then click OK, then OK 
again to close both windows. 

 

 

Click OK on the Login – New window, leaving all other settings at their 
default values. 

The newly created login will be shown in the Logins list. 

 

If the user or group that you have selected needs to be able to create and 
attach new analytical databases to SQL Server, then they must have the 
sysadmin server role assigned to their login. It is strongly recommended 
that this ability be restricted to those users who have the right to run the 
Thermo Security administration software. 

Double-click on the user in the Logins list then click on the Server Roles 
page. To assign the sysadmin role, click to select the Server Roles page 
and check the box sysasdmin. 

 

 

 

 

 

 

 

  

6 
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Click OK to close the login properties dialogue. The selected user or 
group will now be added to the list of SQL Server logins. 

Repeat steps 4 to 8 for each user or group for which you wish to create a 
login. 

Users must be mapped to each database in order to read data from them. 
A quick way to do this is to take the existing group Authenticated Users 
and map the group to each required database. Alternatively, individuals 
or other groups can be mapped separately. 

Add the group Authenticated Users by right-clicking on Logins and 
selecting New Login…. Search for Authenticated Users and add it to 
the list of logins. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Double click on NT AUTHORITY\Authenticated Users and in the 
User Mapping window make sure that db-datareader is ticked for all the 
databases required. 

 

9 
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Save the changes by clicking on File>Save All, then close Microsoft SQL 
Server Management Studio Express. 

 

 

 

4 of 9 Complete 
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The iTEVA Security client software is installed from the iTEVA Security 
installation CD.  

In a networked environment the client application is installed on one or 
more client computers on the network, which are normally the computers 
that are being used to control an iCAP spectrometer. In addition, it is 
often useful to install the client software on the server computer that is 
running SQL Server Express, as this provides an easy way for an 
administrator to create and attach analytical databases, using the Database 
Wizard in the client software. 

 

In a stand-alone environment the client application is installed on the 
single computer that is acting as both client and server.  

The client application must be installed by someone who is a member of 
the ‘Administrators’ group on the computer that it is being installed to. 

If you purchased a PC from Thermo Fisher Scientific when you 
purchased your iCAP instrument, this will have the iTEVA Routine 
software pre-installed on it. It is recommended that you uninstall this 
software first (from Add/Remove programs) and then follow the 
instructions below to install iTEVA Security in its place. 

 

 

 

Insert the installation CD into the CD drive of the client computer. The 
installation program should start running automatically. If it does not; 
using windows explorer, navigate to the contents of the CD drive and 
double-click on the file: setup.exe. 
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Click Install iTEVA. 

 

 

 

 

 

 

 

 

 

 

  

Click Next. The Destination Location dialogue allows you to change the 
location where files are installed. If you do this, always use the same 
location each time you install the software so that files are upgraded 
correctly when subsequent versions are installed. Typically, default 
locations are used for installation. 
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Click Next. The iTEVA Security client application will now proceed to 
install. 

 

 

 

 

 

 

 

  

 

 

 

Click Finish after installation has completed. You will now be prompted 
to install the Thermo Security Client component. 

 

 

 

 

 

 

 

 

 

  

 

 

Click OK. The installation Wizard will begin. 
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Click Next. 

 

 

 

 

 

 

 

 

 

  

Click Install. The Thermo Security client application will be installed. 

 

  

 

 

 

 

 

 

 

 

Click Finish. 
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Click Close on the iTEVA Security installer. When prompted to restart 
Windows, click OK. 
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If you have installed the iTEVA Security client application for use in a 
networked environment, it must be configured to communicate over 
your network. This involves making sure it can that it can communicate 
with SQL Server Express and that it can  communicate with the Thermo 
Security Server application. 

If you have installed iTEVA Security on stand-alone system, skip steps 
1-4 and see the section Running the iTEVA Security Client Application. 

 

To run the SQL Server Client Network utility, click Run from the 
Windows Start button and type ‘cliconfg’ in the run dialogue. 

 

 

 

 

 

 

 

Click OK. The SQL Server Client Network Utility starts. 

 

Select TCP/IP in the list of disabled protocols and click Enable to add it 
in to the list of enabled protocols.  

 

 

 

 

 

 

 

 

 

 

Click OK to close the Client Network Utility 

Complete (networked installations only) 

Configuring the 
iTEVA Security 

client application 
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Before you are able to run the iTEVA Security client, user access must be 
granted in the Security Administration application. By default no users 
are given access to run iTEVA Security, so even administrators must be 
assigned access by the following method. 

 

Open the Security Administration software by double clicking on the 
icon on the desktop. (For Windows 7 a login is required at this point.) 

 

 

In the Security Administration software click on the + next to iTEVA and 
then the + next to Access Control. The various access control parameters 
will be shown. 

 

 

 

 

 

 

 

 

To enable users to run iTEVA Security Client click on Run iTEVA 
Security. The Access Control Dialogue for “Run iTEVA Security” will 
be shown. 

 

 

 

 

 

 

 

 

 

 

 

 

Before running 
the iTEVA 

Security Client 
Application 
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Choose individual users or groups from the list of names and click Add to 
grant access rights. 

 

Repeat the above steps to grant access rights to Edit System Settings. 

 

In the toolbar select File>Save Settings, and then close the Security 
Administration Application. 

 

6 of 9 Complete 

 

 

 

 

 

 

 

Once you have granted access to the current user, the iTEVA Security 
client can be opened. 

The first time you run the iTEVA Security client application from any 
client computer, you must allow the client to locate the Thermo Security 
server.  

 

Start the iTEVA Security client application: 

Start>Programs>Thermo iTEVA Security>iTEVA Security 

The Locate Security Server dialogue may be displayed. If this is not 
displayed skip to Step 5 below. 
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Select the domain on which the Security Service is running, and then 
click Search to start the search process. 

For stand-alone configurations, the local system will be shown when 
clicking search, and you can skip to step 5 below. 

For a networked configuration, continue to step 3. 

 

 

 

 

 

 

 

 

 

If the domain that you are searching is very large (i.e. it has many 
computers that belong to it), the search process may take some 
considerable time. However, if you know the name of the server 
computer on which the security service is running, you can type it in to 
the Server name field directly, instead of searching for it. The server name 
can be found by logging on to the server and then right clicking on the 
My Computer icon and selecting the Network Identification tab. 

When a valid server is found on the domain (i.e. one which is running 
the Thermo Security Server service) its name will appear in the server 
name field and the Stop Search button will be replaced by a Resume 
Search button.  

 

 

 

 

 

 

 

 

  

 

If the server that was found is not the correct server, click Resume Search 
to continue searching.  
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Once the correct server appears in the Server name field, click Test 
Connection and if the connection is valid the status area will report: 
Connection Succeeded. 

 

 

 

 

 

 

 

 

 

  

Click OK. The iTEVA Security log-in screen will be displayed. 

 

 

 

 

 

 

 

 

 

 

 

 

Enter your Windows username and password log to in to the iTEVA 
Security Client application.  

You will now be prompted to create a connection to an analytical 
database. 

 

 

 

5 

6 



Thermo Fisher Scientific                                             Page 42 of 49                                 iTEVA Security Installation Manual v5.8 

Click OK to proceed. This will display the database options dialogue 
from where connections to analytical databases can be managed. This 
process is described in the following sections. 
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To create an analytical database and attach it to SQL Server Express using 
the Database Wizard in the iTEVA Security client application, the 
iTEVA Security Client application must be installed on the same 
computer as SQL Server Express. It will subsequently be possible to 
connect to the newly created database from other instances of the iTEVA 
Security Client application, installed on other client computers on the 
network. 

 

Click Run Database Wizard… from the Application Database options 
dialogue. The Database Wizard dialogue is displayed. 

 

 

 

 

  

 

 

 

 

 

 

Click Create to create and attach a new empty database. 

 

 

  

 

 

 

 

 

 

 

 

   

Creating an 
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Enter a meaningful name for your database and click OK. SQL Server 
Express will now create and attach a new empty database and you will be 
returned to the Database Wizard Page.  

 

 

 

 

 

 

 

 

 

Click Close on the database Wizard. You may now create a connection to 
the newly created database on any client computer that requires it. 
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Click the Add a connection button from the Application Database 
options dialogue.  

 

  

 

 

 

A Data Link Properties dialogue is displayed. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

 

Select or enter the server name of the instance of SQL Server to which 
the database has been attached. By default this will be 
“.\ITEVASECURITY” which is the instance on the local computer. If 
you are connecting to a database on another networked computer, select 
the appropriate entry from the list. 

Make sure Use Windows NT Integrated Security is checked. 

Select the database on the server from the drop-down list that you wish 
to connect to.  

 

1 Creating a 
connection to an 

analytical database
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Click OK. You will be prompted to give a name to the new connection. 
To avoid confusion we recommend giving the connection the same name 
as the database. 

 

 

 

 

  

 

Click OK to create the connection. The connection will now appear in 
the list of available connections.  

 

To make this connection the active connection (i.e. the one that you are 
currently connected to) select it from the drop-down Active connection 
list. 

 

 

 

 

 

 

 

 

Click OK. 

 

Depending on the access rights of the user, when creating a new database 
it may be necessary to grant access to users by following step 12 in the 
Creating User Logins for SQL Server Express section above. 

 

 

9 of 9 Complete 

 

 

Please ensure you have completed all 9 sections of the installation procedure and 
the two extra sections if you are installing iTEVA Security on a network. 
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Troubleshooting Guide 

A ‘Password does not match’ error is reported when attempting to log 
in to the iTEVA Security client application or the Security 
Administration application. I know the password is correct. 
 
This may be caused by failing to correctly set the sharing and security 
model for local accounts. Or, the PC will not accept a user with a blank 
password. 
 
On the client computer, double-click local security policy in the 
administrative tools window:  Start>Settings>Control 
Panel>Administrative tools>Local Security Policy. The local security 
settings dialog box appears. Open the ‘Local Policies’ folder and then 
click on the ‘Security Options’ folder. Scroll down to ‘Network Access: 
Sharing And Security Model For Local Accounts’ on the right hand 
pane and double click on it. A ‘Network Access’ dialog appears. In the 
list box, select ‘Classic – Local Users Authenticate as themselves’ and 
then click OK. Close the local security settings dialog and then close the 
Administrative tools window. You will need to log out of Windows and 
back in again for the settings to take effect. 
 
 
I have been granted the right to run the iTEVA Security client 
application, but when I try to run it – nothing happens. 
 
You do not have the necessary Windows security group membership to 
run the iTEVA Security client application. It is not sufficient for 
iTEVA users to have membership of the windows ‘users’ security group; 
they must have membership of the ‘Power Users’ group. This is because 
Windows will only allow ‘users’ to run ‘certificated’ applications and 
iTEVA is not a ‘certificated’ application. 
 
To grant membership of the Power Users group, follow the instructions 
appropriate to your Windows configuration in Setting up Windows 
Administration in the document SecAdminUserGuide.pdf. 
 
 
I have been granted the right to Edit System Settings in the Security 
Administration software but when I attempt to create and attach a 
database using the iTEVA database Wizard, I get an error reported: 
‘Cannot alter the application role iTEVA’ because it does not exist or 
you do not have permission’. 
 
The SQL Server login for your user account has not been assigned the 
sysadmin server role.  
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Log into the computer that is running SQL Server Express as a user 
who is a member of the administrators group on that machine. Start 
SQL Server Management Studio Express and connect to the 
ITEVASECURITY instance of SQL Server:  
 
Start>Programs>Microsoft SQL Server 2005 

 
Expand the security branch of the tree in Object Explorer and then 
expand the logins branch. Double-click on the login name for the user 
account that you wish to modify. 
 
On the Login Properties dialog, select the Server Roles page and check 
the sysadmin checkbox. Click OK and shut down Sequel Server 
Management Studio Express.   
 
 
I have been granted an access right in the Security Administration 
software - but when I log on to the iTEVA Security client application I 
find that I cannot perform the corresponding operation. 
 
It is likely that you have ‘inherited’ an access control setting through 
being a member of a Windows security group that has been denied the 
access right in question. 
 
Review the group membership for your Windows account and check 
that none of the groups that you belong to have been denied the access 
right in question. Care is required when denying an access right to a 
group, since an ‘access denied’ setting will always take precedence over 
an ‘access granted’ setting. You can always check the value of the 
accumulated access rights for your user account from the iTEVA client 
application. Go to Tools>Options>Access Rights. 
 
 
SQL Server Management Studio Express does not run. 
 
The Windows component, Internet Information Services (IIS) is 
required for certain aspects of SQL Server to work. Not having IIS 
installed will not affect any functionality of the iTEVA Security 
software, but may cause the installation of SQL Server Management 
Studio Express to fail. 
 
Install IIS through Control Panel>Add or Remove Programs>Add 
Remove Windows Components. If not available here, it will need to be 
installed from your Windows installation CD. 
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Following an upgrade of the iTEVA Security software the application 
database upgrade fails. 
 
The database needs to be detached and reattached to the SQL server 
prior to attempting to upgrade the database. 
 
Enter the Database Wizard via Control Center, 
Tools>Options>Application Database and detach the database you wish 
up upgrade.  Once the detach process is completed, reattach the 
database and set the active connection to the database you wish to 
upgrade (the one that has just been detached and reattached) and select 
ok.  The database should upgrade successfully. 
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